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ABSTRACT

Digital design is a part of human life nowadays; we cannot deny its existence in
our life. The simple example would be our computer. Behind its functionality in doing
its jobs and task, there is a complex design of digital system that play the role part of
executing the operation so that our computer can perform its task when given one. On
the other hand, square root is one of an important part in scientific calculation, computer
graphic applications. Hence, square root is one of the operation that important for
computer to performs its task. The programming languages used is VHDL (Very High
Speed Integrated Circuit Hardware Description Language). The software used is ISE
10.1 that were specially made to interface with Xilinx development board. Through
successfully creates it, simulation can be done and verify the system with it
functionality. Hence, a digital system that operates as fixed —point square root is

created.



Vi

ABTRAK

Sama ada sedar atau tidak, sistem digital merupakan perkara yang menjadi satu
keperluan masakini. Contoh yang jelas sekali ialah komputer peribadi. Suatu operasi
ringkas yang dilaksanakan oleh komputer mempunyai mekanisme yang
menggerakkannya. Terdapat suatu reka bentuk sistem digital yang memainkan peranan
membolehkan fungsi yang dijalankan beroperasi dengan baik dan sempurna.Semakin
rumit tugas yang dilakukan, semakin rumit juga binaan sistem digital untuk
menggerakkan fungsi tersebut. Melihat kepada operasi punca kuasa, ia adalah suatu
operasi penting dalam pengiraan saintifik dan aplikasi imej. Dengan ini, suatu sistem
digital direka dengan tujuan untuk menjalankan operasi punca kuasa dengan
memasukkan suatu nilai dan secara automatik sistem tersebut akan mengira nilai punca
kuasa nilai yang dimasukkan. VHDL digunakan untuk memprogram sistem digital
tersebut. Aplikasi VHDL yang akan digunakan ialah ISE 10.1 yang dibuat oleh syarikat
Xilinx untuk FPGA keluaran syarikat tersebut. Konsep atau teori operasi yang
digunakan ialah Non — Restoring Square Root Algorithm. Di akhir projek ini, simulasi
ke atas sistem yang direka dapat dilakukan dan diuji samada ia dapat berfungsi sebagai

yang dijangka. Dengan itu, suatu sistem digital yang berfungsi telah berjaya direka.
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CHAPTER 1

INTRODUCTION

1.1 Overview

Digital system design has becoming a crucial technology that moves the
modern world. It has been contributing its hands in variety of field of activities. From
industrial to daily life, mankind cannot deny that digital system has been an

important need in this modern world now and future.

So, this development of technology of digital system is going forward for the
sake of modern technology in trying to reduce the cost production and maximized the
output of production as example for industrial field. In people daily life, they
expected in to do various kind of task that would ease our job despite being portable
and has limited resources. For example a handset, which in nowadays users not only
can use it as communication tools but also as entertainment tools. This is thanks to
digital system technology that has been developed and still developing as it offers

many possibilities in improving it.

In developing digital system design, a common techniques use is to used
VHDL language in order to programmed it in software where simulation can be
perform to do analysis of designed system. This approached has its advantages as its
does not make any cost as the programmed system can be programmed and erased

without the effort to alter the hardware



VHDL stands for (very high speed integrated circuit hardware description
language) is languages that enable the programmer describe the circuits of digital
design in textual form. So, it is preferred than other programming language such as

C++, Visual Basic and MATLAB which is usually a sequential languages.

Usually the hardware used would be a development board such as FPGAs
that being offers by many manufacturer, for example is Spartan-3 from Xilinx. This
development board has a chip that can be used to implement the designed digital

system for analysis afterward.

1.2 Objective

This project has 3 objectives;

1. To use a description language to creates digital system design.
2. To choose and understand a suitable algorithm to be implemented.
3. To operates a Fixed-point square root function with a digital system

design by simulation.

1.3 Scope of project

1. Output of the system would be in Fixed-point only, which means no
floating point will be expected to be in the output.

2. The language used would be VHDL that stands for (very high speed
integrated circuit description language).

3. The input would have maximum range of 16 bit which means the range
would be 0 to +65535 of unsigned number.

4. The design would be running trough simulation only, no implementation

into hardware involved.



1.4 Problem Statement

The square root function is a basic operation in computer graphic and
scientific calculation application. Due to its algorithm complexity, the square root
operation is hard to be designed in digital system. Digital system is the system that
can realize the operation of square root operation in hardware. As known, digital
system has been used in daily life or industrial purpose that may have been in need of
square root operation to fully its functions.

So, this project is being done to help create a prototype of digital system
design that can operate as square root operation that would be implemented in
hardware devices. Furthermore, the design created is reduced in cost and high in

performance by choosing the appropriate algorithm.

1.5  Project Contribution

A prototype of functioning digital system that operates the fixed-point
square-root function with accurate output within the required limitation of Spartan-3
Xilinx FPGA board.

A systematic approach of designing a digital design using VHDL language

with ISE 10.1 as the platform software used.

1.6 Thesis Organization

This thesis is organized into five chapters. The first chapter introduced the
introduction of this project, project objective, scope of work, and contribution of this

project.



Chapter 2 present the related reference studied that being used to do this

project. The algorithm used is also introduced in this chapter.

Chapter 3 would explain about the project methodology which clearly

explained about how this project is planned and organized in completing the project.

Chapter 4 presents the result for the system designed and discussion of

overall result.

In the final chapter, the project research is summarized and the
recommendations for future works are presented. The cost of the whole project and

commercialization of it is also discussed here.



CHAPTER 2

LITERATURE REVIEW

This chapter explained the VHDL language, digital system design and the

algorithm for square root function.

2.1  Digital System Design

Digital system can be defined as “a combination of devices designed to
manipulate logical information or physical quantities that are represented in digital

form; that is, the quantities can only take discrete value [7].

Other definition for Digital system is “an electronic system that operates on

two-valued electric signals, referred to as ‘1’ and ‘0’ ” [5].

While, digital system design is defined as “a process that starts from the
specification of requirements and produce a functional design that is eventually

refined through a sequence of steps to a physical implementation.”[2].

As integrated technology has enable more and more component to be in a
chip, digital system has become more complex. When digital system has become

complex, detailed design of the system at gate and flip-flop level would be tedious



and time-consuming. For this reason, hardware description languages have become

important in digital system design [8].

VHDL will naturally leads to top — down design methodology, in which the
system is first specified at a high level and tested using a simulator. After the system
is debugged at this level, the design can gradually be refined, leading to a structural

description closely related to actual hardware implementation [8].

Consider the design development of application-specific integrated circuit
(ASIC) for a specific purpose, unlike a microprocessor that being programmed to do
variety of task. The Figure 2.1 shows us the typical sequence activities that typically
takes place in ASIC design [2].



Requirements

A 4

Functional Design Behavioral simulation
Register transfer RTL Simulation
Level Design Validation

A4

Logic Simulation
Logic Design Verification
Fault Verification

A4

Circuit Design Timing Simulation

l

Physical Design Design Rule Checking

!

Description for manufacture
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Figure 2.1: Typical activity flow in top-down digital system design

The first step is to consider the specification of the requirement that the chip
is to satisfy. In other word, developers have to consider the limitation of the chips in
designing a digital system so that the designed system is capable to operate on the
chip. With these functional requirements, one can create a preliminary high-level
functional design. Furthermore, simulation is often used to converge to a functional

design that can meet the specified performance requirements [2].

With the initial functional design, developers refined it to produce a more
detailed design description at the level of registers, memories, arithmetic units, and

state machines. This is the register transfer level (RTL) of the design [2].



Subsequence refinement of RTL description produces a logic design that
implements each of RTL components. Both RTL and logic simulation can ensure

that the design meets its original specification [2].

At each level of these levels describe the design with various components. At
higher or abstract level, it has a smaller number of more powerful components such
as adders and memories. At lower and less abstract levels, it has a larger number of

simpler, less powerful components, such as gates and transistors [2].

Each level of design hierarchy corresponds to a level of abstraction and has
an associated set of activities and design tools that support the activities at this level.
Moreover, throughout this hierarchy, simulation is commonly used technique.
Hardware description languages such as VHDL are targeted for use throughout this

design hierarchy and provide some degree of uniformity across the various levels [2].

22 VHDL

VHDL stands for Very High Speed Integrated Circuit Hardware Description
Language. This VHDL language can be used for several goals in mind. “It may be
used for the synthesis of digital circuits, verification and validation of digital designs,

test vector generation for testing circuits, or simulation of digital systems” [2].

VHDL can be described as a general-purpose hardware description language
that can be used to describe and simulate the operation of wide variety of digital
systems, ranging in complexity from a few gates to an interconnection of many

complex integrated circuits [8].

VHDL is one of three popular modern HDL languages. A second HDL is
Verilog, it was developed to have a syntax similar to the C programming language.
The third HDL is SystemC that is developed on 2000s by several companies. Some



people say that SystemC is not a hardware description language but rather a system

description language [5].

Back to history of VHDL development, “The Department of Defense (DoD)
sponsored this program with the goals of developing a new generation of high —
speed integrated circuits” [2]. This development continues until a team of DOD
contractor is awarded the contract to develop the language, and the 1% released in
1985 [2].

It was then transferred to IEEE for standardization, after which
representatives from industries, government, and academic were further involved in
its development. Many standards have been released since then, and the latest is
IEEE 1164 standard [2].

Comparing with conventional procedural programming languages, such as C
or Pascal, that’s describing procedures for computing a mathematical function or
manipulating data, VHDL is different. Rather than the program is a recipe consisting
of a sequence of steps defining how to perform a computation or manipulate data

value, VHDL language describes digital systems.

One of the advantages of using VHDL languages is that it was designed to be
technology independent. If a design is described in VHDL, and implemented in
today’s technology, the same VHDL description could be used as a starting point for

a design in some future technology [8].

2.3  Square Root Algorithm

There are many square root algorithms available for implemented using
VHDL language. For example are these three algorithms: Newton-Raphson method,
SRT-Redundant method and Non-Restoring Square Root Algorithm [1].
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The Newton-Raphson Method operates with Iteration methods that start with
initial (guess) value and improved accuracy of the result with each iteration. While
the SRT-Redundant method based on recursive relation, in each iteration will be one
digit shift left and addition. This method may generate a wrong resulting value at the
last digit position [1].

Next, the Non-restoring method uses the two’s complement representation for
the square root result. With this method, an exact result value can be generated at
each iteration even in the last bit. Furthermore, there is no need to do complex

calculation as appear in SRT-Redundant method [1].

Non — restoring method is chosen to be used in this project, this is because of
several advantages it has compared to other algorithms. Firstly, it only requires one
traditional adder/subtractor in each iteration compared to Newton — Raphson Method

which needs multipliers or even multiplexors [9].

Secondly, it generates the correct resulting value even in the last bit. Next,
based on the resulting value of the last bit, a precise remainder can be obtained
without any correction or addition operation. Finally, it can be implemented at very
fast clock rate because of the very simple operation at each iteration. Hence, the Non

— restoring algorithm is adopted to do this project [9].

2.3.1 Mathematical Calculation

In this section, an example is shown to show how is the calculation of square
—root by hand. So that, a clear understanding how the square — root value is obtained
without using calculator. The same method shown in [3] can be used to calculate the

example below.

Example: Find V127 to one decimal place.
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First group the numbers under the root in pairs from right to left, leaving either one
or two digits on the left (6 in this case). For each pair of numbers it will get one digit

in the square root.

To start, find a number whose square is less than or equal to the first pair or first

number, and write it above the square root line (2).

V1.27

Square the 1, giving 1, write that underneath the 1, and subtract. Bring down the

next pair of digits.

Then double the number above the square root symbol line (highlighted), and write it
down in parenthesis with an empty line next to it as shown.
I
v1.27
-1

(2_) 027

Next think what single digit number something could go on the empty line so that
twenty-something times something would be less than or equal to 27.

21x1=21

22 x 2 =44, s0 1 works.



Write 1 on top of line. Calculate 1 x 21, write that below 027, subtract, bring down

the next pair of digits (in this case the decimal digits 00).

1
+1.27.00
-1

(21)

[

RN

02
-02

h

Then double the number above the line (11), and write the doubled number (22) in

parenthesis with an empty line next to it as indicated:

11
v 1.27.00
-1

(21) 027
-021

(22_) 6 00

Think what single digit number something could go on the empty line so that two
hundred twenty-something times something would be less than or equal to 600.
222 x2 =444

223 x 3 =669, so 2 works.

v 1.27.00

1

(21) 027
-021

(222) 6 00

Calculate 2 x 222, write that below 600, subtract, and bring down the next digits.
Then double the 'number' 112 which is above the line (ignoring the decimal point),
and write the doubled number 224 in parenthesis with an empty line next to it as
indicated:

12
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11.2
\1.27.00.00
-1
(21) 027
021
(222) 6 00
-4 44
(224 )1 56 00

2246 x 6 = 13476, 2246 x 7 = 15729, which is less than 15600, so 6 works.

11.2 6
4 1.27.00.00
-1
(21) 027
021
(222) 6.00
4744
(224 )1 56 00

Thus to one decimal place, V127 =113
2.3.2 Algorithm Calculation

The algorithm used is Non — restoring square root algorithm. In this section, the

algorithm is used to calculate the binary square — root value.
Binary Square Roots

In general, the procedure consists of taking the square root developed so far,
appending 01 to it and subtracting it, properly shifted, from the current remainder. The 0
in 01 corresponds to mutliplying by 2; the 1 is a new trial bit. If the resulting remainder
is positive, the new root bit developed is truly 1; When the remainder goes negative, first
enter a 0 as the next root bit developed. To this append 11. This result is shifted left the
proper number of times and "added" to the present remainder. Using the same method in

[4], it can solve the example as shown in Figure 2.2.
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00 11 <--- positive: first bitis al
-1 01 <--- Developed root is "1"; appended 01; subtract

11 10 11 <--- negative: 2nd bit is a 0
+10 11 <--- Developed root is "10"; append 11 and add.

11 11 10 11 <---Overflow: 3rd bit is a one
1 00 11 <---Developed root is "101";append 01 and subtract

1 00 00 11 10 <--- positive: 4th bit is a one

Figure 2.2: Binary calculation using algorithm

The binary number ‘01111111’ equal to 127,
The fixed-point answer is ‘1110’ that is equal to 11 in decimal with remainder of 6
127-112=6




CHAPTER 3

METHODOLOGY

3.1 Introduction

The methodology of this project is represented in this chapter, which will
explain the steps and flow being done in order to complete this project. In other

words, the development of the digital system will be explained in this chapter.

3.2  Research Methodology

Referring to the Figure 3.1, before we can develop the function, we have to
understand the operation of the function, which is the square root function. So we
have to know first how to yield a correct value of square root input value using the
algorithm we have chosen. In other words, we have to know and understand the
operation of the algorithm In order to do that, we have to use the algorithm to

calculate a square root value.

After that, we have to understand some digital design component involved in
our algorithm operation. Some of the component is shift register, counter, adder and
data register. After we understand each component involved, its times to design the
digital system. We have to keep in mind the system design need some control

operation as these components cannot be enabled at the same time.
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As mentioned earlier, there would be a sequence of operation involved in this
system. So, we have to make a Control Unit to control the operation of each
component in the system that we describe as Data Path Unit. When we finally
incorporate these Control Unit and Data Path Unit, a completely functional system is

produced that enable to operates square root operation.

As described in Figure 3.1, the Data Path Unit needs to be verified first
before designing the Control Unit. In order to do that, we need software that
compatible with VHDL language and can done a simulation of designed system. So,
we use ISE 10.1 software that also use for implementing digital design to Xilinx
manufactured FPGA board.
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Figure 3.1: Flow Chart of the Project
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3.3  Square Root Operation and Algorithm

The square root algorithm chosen in this project is Non-Restoring Square root
algorithm. This algorithm was chosen for it’s simplicity in its operation compared to
other algorithm. Thus, it would avoid using much component to compute each
operation in the algorithm. The pseudo code for this algorithm is enlisted in Figure
3.2.

Let
D be 32-bit unsigned integer
Q bel6-bit unsigned integer (Result)
R be 17-bit integer (R = D - Q)

[*input value*/
[*Square-root value*/

/*Remainder*/

Algorithm
Q=10
1;:]; ]D= 15 to 0 do I*for each root bit*/
if (R >=0)
R=R=<2jor{(D>=(i+i)&3): /*new remainder:*/
R=R-({Q<=<2)orl}) 1*-Q01%/
Else
R=(R<<Zjor (D>>(1+1) & 3); *new remainder:*/
R=R - {(Q <<2)or3) . .
Endif FQLr
if (R == (0} then
Q=(Q<=<1)orl; Fnew Q:/
Else
Q=(0Q=<1)or; [*newQ:*/
End if

Figure 3.2: Pseudo Code of the Algorithm

The focus of the algorithm is on the partial remainder with each iteration. It
generates a correct resulting bit in each iteration. The operation is subtraction or

addition based on the sign of previous iteration.

Based on the flow in Figure 3.3, we can see the operation is mostly depends
on the remainder of iteration. The operation starts with initial condition of remainder

equal to zero. After iteration happens, its will use the current remainder to examine
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the sign of the remainder. Depending on the remainder sign it will enter the square-

root value which is Q. This process will continues until i equal to zero which is

representing each bits of the answer. So, if the answer is 4 bits, its will loop the

operation four times.

D be 16-bit unsigned
Start integer (input)

;

v Q be 8-bit unsigned integer

(results)
D => input data

R be 10-bit integer
+ (remainder)

Q=>0,R=>0,i=7

=
-

h

R>=0

b

R=R+((Qx<<2) or 3)

R = ( R <<2 or (D>>(i+i)) R = (R <<2 or (D>>(i+i))

R=R-((Q<<2) or1)

(Qz<1) or0

(Q<<1) or1

0 N i1=>i
Y

Figure 3.3: Flow Chart of the Algorithm
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3.4  Digital System Design

In this part, the structural description of the digital system designed is presented

here. It divided into three parts, the overall system, data path unit and control unit.

3.4.1 Overall System

20

Figure 3.4 shows the block diagram of the whole system. As you can see, there is

two main components that integrate to create the system. In these components also have
a few smaller components operating inside it. The algorithm used is implemented in the
Data Path Unit. So, the design of the algorithm is the Data Path Unit itself. The Control

Unit is the one that control the Data Path Unit operation. With integrating these two

equally important components, the system will function correctly.

Data
Master (overall system)
1
// |16
Y y
Control Unit Data Path Unit
1 Control 16
/ Vector /
/>
6
Output
Real /
/
1 1
7'y
j |
/

Figure 3.4: Block diagram of overall system

Output



3.4.2 Data Path Unit
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Figure 3.5 shows us the data path unit and its components inside it with some

interconnection between them are visible. An adder/subtractor is used in this Data Path

Unit. When the control input is 0, it will subtract, otherwise it adds. One resulting bits of

the answer will generated for each clock cycle. In this case, for input value of 16 bits, the

total clock cycle for generating the answer bits is 8 clock cycle.

Data Path Unit |- 16

D => 16 bit

Q=>8 bit <—Q<]<—
»| Data Register
\ 4 \ 4 \ A 4 Y

A

8

Add /Sub
10 bit

0 sub
1add

Counter

1 R=>10-bit

Figure 3.5 Data Path Unit

» Output
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3.4.3 Control Unit

Figure 3.6 shows the block diagram of Control Unit, which is consist of finite
state machine. The Control Unit main purpose is to control the Data Path Unit
Operation. This was done by connecting the entire enable signal for each component
in Data Path Unit to a data bus known as Control Vector. With the enable signal
connected to Control Unit, it can control for which component would be enable and
operates at one time. With this in hand, the operation of Data path Unit can be

operating smoothly and the output can be obtained.

ini Data
Finite
Path
State
Load .
. Control Vector 0 »| Unit
Start 1| Machine Control Vector 1 |
/L |
Control Vector 2
Control Vector 3 |
1 .
Reset 7 Control Vector 4 Add/Sub

A 4

Control Vector 5

Outpu/t True
-/
1

Figure 3.6: Control Unit Block Diagram

Figure 3.7 show us the state available in the Data Path operation and the Table
3.1 shows us the corresponding control vector value for each state given. From the state
diagram we can see the operation of square root will execute only if the start signal is
activated. When the operation is activated, it will go through a sequence of state and
looping the sequence of state until the feedback signal from Data Path Unit signifies that

the current value in the output register is the real output.
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We can see from here that, without the control output, the data path unit would
unable to process the data given correctly. Thus, it would be impossible to acquire the

correct answer without it.

Table 3.1: Control Vector signal for each state

State Load D_Shift Q_Shift Remainder | Counter AddSub
SO 1 0 0 0 0 0
s1 0 0 0 0 0 1
S2 0 0 0 1 0 0
S3 0 0 1 0 0 0
s4 0 1 0 0 1 0
S5 0 0 0 0 0 0
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Reset =1

ﬂ Start=0

Clock Trigger

Clock Trigger

Clock Trigger

Output true=1

Reset =0

\

Clock Triggen

Figure 3.7: State Transition

3.5 VHDL Coding

The VHDL coding as mention earlier is the language that describes the digital

system. With structural description is acquired in above part, we can do the coding with

VHDL. This part is also divided by three parts that is Overall System, Data Path unit and
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Control Unit. The software used is ISE 10.1 which is capable of programming in both

Verilog and VHDL language. Simulation also can be done using the same software.

3.5.1 Overall System

The coding in Figure 3.8 describes the Figure 3.4, which is the block diagram of
the whole system. These coding describe the behavioral or operation of the system and
the interconnection between its components, that is Data path Unit and Control Unit.
Notice the italic word of TMAP and Cont_Unit which represent the Data Path Unit and
the Control Unit. The bold word of M1 is describing the connection of Data Path Unit
while M2 is for Control Unit.
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architecture Behavioral of master is
signal CV : STD_LOGIC_VECTOR(5 downto 0);
signal CountStop : STD_LOGIC;
component TMAP - - - - Data Path Unit
generic(width:integer:= 16);
Port (enable_D2 :in STD_LOGIC;
enable_R2:in STD_LOGIC;
enable_Q2:in STD_LOGIC;
enable_count2:in STD_LOGIC;
enable_as2 : STD_LOGIC;
Load2 : in STD_LOGIC;
Reset: in STD_LOGIC;
clock _du:in STD_LOGIC;
count_i2 : out STD_LOGIC;
Data:in STD_LOGIC_VECTOR ((width-1) downto 0);
Output : out STD_LOGIC_VECTOR(((width/2)-1) downto 0);
Output_2 : out STD_LOGIC_VECTOR(((width/2)-1) downto 0));
end component;
component Cont_Unit - - - - control unit
Port ( clock_CU :in STD_LOGIC;
reset CU:in STD_LOGIC;
start CU :in STD_LOGIC;
| ;in STD_LOGIC;
Cont_Vector : out STD_LOGIC_VECTOR (5 downto 0));
end component;
begin
M1: TMAP generic map(16) port map (Load2 => CV(5), enable_D2 => CV/(4), enable_Q2 =>
CV(3), enable_R2 => CV/(2), enable_count2 => CV/(1),enable_as2 => CV(0),Reset => reset_m,
clock_du => clock_m, count_i2=> CountStop,Output_2 => output_final, Data => data_m,
Output => output_m);
M2: Cont_Unit port map (clock_CU => clock_m, reset_CU => reset_m,
start CU => start_m, | => CountStop, Cont_Vector => CV);
output_true <= CountStop;

end Behavioral;

Figure 3.8: VHDL coding for Master (overall system)
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3.5.2 Data Path Unit

The coding in Figure 3.9a, 3.9b, 3.9c describes the Figure 3.5, which is the
block diagram of Data Path Unit. The VHDL code describes the behavioral of the
Data Path Unit and interconnection of its components. Notice the italic word of
D,Q,R,N,AddSub,count_reg and Out_reg which represent the input register, solution
register, remainder register, not gate, adder/subtractor, counter and the output
register. The bold word of U1 is describing the connection of D while U2 is for Q,
U3is for R, U4 is for N, U5 is for AddSub, U6 is for count_reg and U7 is for Out-

reg. The behavioral description in VHDL for each component is in the appendix.

architecture Behavioral of TMAP is

signal Al : std_logic_vector (1 downto 0);

signal A2,B3: std_logic_vector ( ((width/2)-1) downto 0);
signal Add2 : std_logic_vector ( (((width/2)+2)-1) downto 0);
signal B2,Q1,count_i3:std_logic;

constant mask : std_logic :='1";

component D - - - - D register

generic(width:integer:= 16);

Port ( Output_D1 : out STD_LOGIC_VECTOR ( 1 downto 0);
Data_ D :in STD_LOGIC_VECTOR ((width-1) downto 0);
Enable_D :in STD_LOGIC;

Load : in STD_LOGIC;

Clock_D:in STD_LOGIC;

Reset D:in STD_LOGIC);

end component;

component Q - - - - Q register

generic(width:integer:= 16);

Port ( Output_Q:out STD_LOGIC_VECTOR (((width/2)-1) downto 0);
Leftl Q:in STD_LOGIC;

Enable_ Q:in STD_LOGIC;

Clock_Q:in STD_LOGIC;

Reset Q:in STD_LOGIC);

end component;

Figure 3.9a: VHDL coding for TMAP (Data path Unit)



component R - - - - R Register

generic(width:integer:= 16);

Port ( Data_R:in STD_LOGIC_VECTOR ((((width/2)+2)-1) downto 0);

Enable_R:in STD_LOGIC;

Reset R:in STD_LOGIC;

Clock_R:in STD_LOGIC;

Output_R3: out STD_LOGIC_VECTOR (((width/2)-1) downto 0);
Output_R1 : out STD_LOGIC);

end component;

component N - - - - Not gate logic

Port (In_N:in STD_LOGIC;

Out_N:out STD_LOGIC);

end component;

component AddSub - - - - Adder/Subtractor
generic(width:integer:= 16);

Port (A_in2:in STD_LOGIC_VECTOR (1 downto 0);
A_inl:in STD_LOGIC_VECTOR (((width/2)-1) downto 0);
B_in3:in STD_LOGIC;

B_in2:in STD_LOGIC;

B_inl:in STD_LOGIC_VECTOR (((width/2)-1) downto 0);
S_out: out STD_LOGIC_VECTOR ((((width/2)+2)-1) downto 0);
control_op : in STD_LOGIC;

Clock_as: in STD_LOGIC;

enable_as: in STD_LOGIC;

reset_addsub : in STD_LOGIC);

end component;

component count_reg - - - - Counter

Port (clock_count :in STD_LOGIC;

reset_count: in STD_LOGIC;

enable_count : in STD_LOGIC;

count_i : out STD_LOGIC);

end component;

Figure 3.9b: VHDL coding for TMAP (Data path Unit)
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component Output_reg - - - - Output Register

generic(width:integer:= 16);

Port (in_reg:in STD_LOGIC_VECTOR (((width/2)-1) downto 0);
out_reg:out STD_LOGIC_VECTOR (((width/2)-1) downto 0);
clk_reg:in STD_LOGIC;
enable_reg : in STD_LOGIC;
rst_reg:in STD_LOGIC);

end component;

begin

U1: D generic map(16) port map ( Output_D1 => Al,Enable_D => enable_D2, Load => Load?2,
Reset_D => Reset,Data_D => Data, Clock_D => clock_du);

U2: Q generic map(16) port map ( Enable_Q => enable_Q2, Clock_Q => clock_du,
Reset_Q => Reset, Output_Q => B3, Leftl Q => Q1);

U3: R generic map(16) port map ( Data_R => Add2, Enable_R => enable_R2,
Reset_R => Reset, Clock_R => clock_du, Output_R1 => B2, Output_R3 => A2);

U4: N port map ( In_N => Add2(5), Out_N => Q1);

U5: AddSub generic map(16) port map ( A_inl => A2, A_in2 => Al, B_inl => B3,
B_in2 => B2, B_in3 => mask,S_out => Add2, control_op => B2, reset_addsub => Reset,
Clock_as => clock_du,enable_as => enable_as?2);

U6: count_reg port map (reset_count => Reset, enable_count => enable_count2,

clock_count => clock_du, count_i => count_i3);

U7: Output_reg generic map (16) port map (in_reg => B3, out_reg => Output_2 , clk_reg =>
clock_du,

enable_reg => count_i3, rst_reg => Reset);

Output <= B3;

count_i2 <= count _i3;

end Behavioral;

Figure 3.9c: VHDL coding for TMAP (Data path Unit)
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3.5.2 Control Unit

The coding in Figure 3.10 describe the Figure 3.6, which is the block diagram of
the Control Unit. These coding describe the behavioral or operation of the Control Unit
as a Finite State Machine. Notice the italic word is the coding that does the state
transition and conditioning according to Figure 3.7. While the bold one is the coding that
assigns the value of control vector for each corresponding state computed from Table
3.1.
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architecture Behavioral of Cont_Unit is
type state is (S0,S1,52,S3,54,S5);
signal y :state;

begin

state_transition:

process(reset_CU,clock_Cu,y)

begin

if reset CU ="1"then

y <= S0;

elsif (clock_CU="0"and clock_CU'event ) then

casey is

when SO => if start_CU = "1" then y <= S1; else y <= S0;end if;
when S1 =>y <= S2;
when S2 =>y <= S3;
when S3 =>y <= 54;
when S4 => if | ='1' then y <= S5; else y <= S1;end if;
when S5 =>y <= S5;
end case;

end if;

end process state_transition;

output:
process(y)
begin

Cont_Vector <= (others =>'0");

caseyis
when S0 => Cont_Vector <= ""100000"";
when S1 => Cont_Vector <= "'000001";
when S2 => Cont_Vector <= ""000100"";
when S3 => Cont_Vector <= "001000";
when S4 => Cont_Vector <= "'010010"";
when S5 => Cont_Vector <= ""000000"";

end case;

end process output;

end Behavioral;

Figure 3.9: VHDL coding for Cont_Unit (Control Unit)



CHAPTER 4

RESULT AND DISCUSSION

41 Introduction

The result of this project is represented in this chapter, which mostly from
simulation graph. Each stage result would be represented here by form of simulation

graph.
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4.2 Data Path Simulation Result

From the Figure 4.1 below, the Data Path Unit is tested at 8 bit input value.
Since the simulations only involve Data Path Unit, the enable signal for each
component is manually configured. By referring to simulation result in Figure 4.1
and Figure 3.4, enable_d2 is for D register(shifting enable), enable_r2 is for R
register, enable_gz2 is for Q register, enable_c is for counter, enable_as is for
adder/subtractor and load is for D register also(store data). Clock_du is the main
clock to the Data Path Unit, count_i2 is the feedback signal to Control Unit that
triggered when the counter has reach the required cycle of operation to get the final

correct answer.

00us
Current Simulation
Time: 6 us Jus 1us 2us Jus dus Sus Bus
Lot b v b b v b
gllenable_d2 0 | |
gllenable_r2 0 |
gllenable_q2 0 | | I | I
gllenable_c.. | 0 []
gllenable_as2 | 0 1
gllload2 ] I
gllreset 0 []
gllclock_du 0 | | | | | | | | | |
gllcount_i2 0
ﬁ’[data[?:ﬂ] 0 4
B output[3.0] 4 1] 1 2 0
B output_2[3:0] | 4hU 0 2 1]
gl!period 2. 200000000
gl duty_cycle 05 ns
&l,l offset 1. 100000000

Figure 4.1: Data Path Simulation Result

‘Data’ is the input value given to be calculated, while “output’ is the output
signal from register Q which store every answer generated for each cycle. Output_2

is the output of the output register in Data Path Unit that would be the real output of
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the whole system. From the Figure 4.1 we can see the input of 8 bit with a value of 4
would compute answer after 4 cycles with value of 2. Notice that the all the enable
signal is going through a sequence of pulse that cycle 4 times to compute the last
answer. The signal named “output’ shows us the answer for each cycle, but the real
answer is considered after the signal named ‘count_i2 is triggered as 1. Hence, the
signal named ‘output_2’ take the value from signal ‘output’ to be the real output of

the system.

4.3 Control Unit Simulation Result

Figure 4.2 shows us the simulation results of the Control Unit. Since it only
the Control Unit being simulated, the signal ‘I’ , signal reset, signal and signal start is
manually configured. Signal ‘I’ is the feedback signal from Data Path Unit that
triggered the when the counter has reach the required cycle of operation to get the
final correct answer. Start signal is the signal that triggered the operation to start its
operation. The signal ‘cont_vec’ is the control vector signal that connected to all

enable signal of Data Path Unit components.

Current Simulation
Time: 6 us P us 1us 2us 3us 4 U5 5us

e I N A R NN ARV AREY
gl reset_cu 1 J —|
gl start_cu 0 |_|
il 0 [ ]

B cont_vec.. 32 32 g1 aNBE YaNea 0 37
%J!F]Efitld 2. 200000000
gl duty_cycle 0.5 0.5
é,ﬂ offset 1. 100000000

Figure 4.2: Control Unit Simulation
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From the Figure 4.2 that before the signal start is triggered, the value of
control vector signal will remain at 32 which corresponding to state SO referring back
to table 3.1. When the signal start is activated, the control vector output will sends a
sequence of value that corresponding to a sequence of state accordingly to Table 3.1
and Figure 3.7. Until the signal ‘I’ is activated, it will loop the sequence value
continuously. When the signal ‘I’ is activated, the control vector will constantly send
0 value as long as the signal ‘I’ is activated and the reset is not activated. When the
reset signal is activated, the control vector signal will return to value 32 that is state
SO.

We can see that the Figure 4.2 itself describe the behavioral of Table 3.1 and
state diagram of Figure 3.7. So, the control vector is can be assure to be working

accordingly as required.

4.4  Overall System Simulation Result

Figure 4.3 shows the overall system result of the simulation being done. The
input data value is 25 in decimal. Output_m signal shows the answer for every cycle
of operation till the last answer. While ‘output_f’ signal is the output of the system
that only take the value when the signal ‘output-true is triggered into 1 which means

that is the correct value of output. In this case, the correct value is 5 in decimal.

As we know that the square root value of 25 is 5, this concluded that the
simulation was successful as the operation done creates the correct answer of square-

root value of input data.
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Input Value
Current Simulation
Time: 10 us Pus Tus  2us  3us  4us  Sus  Gus  Tus  Sus  Jus
cccn b beeor b b b b b b L
B Bl data_m(15:0] [ 25 25
gl starl_m 0 |
gllreset_m 0
Bl outout_m[7:0]| 3 | ] 1 2 4
& B output 1. 5 ! 0 5
glloutput_true | 1
i';J!Deriod 2. 200000000
gl duty_cycle 0.5 0.5
M!Dﬁsei 1. 100000000

45 Performance

Figure 4.3: Overall Simulation result

Performance of the design can be extracted after the analysis of the design,

from the simulation we have some of the performance result that is:

Total Memory Usage: 161216 kilobytes

Total Real time to Xst completion: 9.00 seconds

Total CPU time to Xst completion: 8.91 seconds

Time taken to complete process is 7.824 ns, with the frequency of 127.812 MHz.
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4.6  Costing and Commercialization

The cost of this project is as listed below:
License of software ISE 10.1 : RM 200.00
Hardware used : None
Total : RM 200.00

While for potential of commercialization, this project is still in development
or research. So it’s not suitable to be commercializing it yet. The functions its offers
are not significant enough to be commercialize on its own. Hence, its need to be
accompanied with other product, implementation on hardware or component so that

it can be commercializes.



CHAPTER 5

CONCLUSION AND RECOMMENDATION

51 Conclusion

The proposed 16- bit Fixed-Point Square Root System is a digital system that
being developed using VHDL languages. It is being simulated using ISE 10.1 by
Xilinx to verify the design and functionality. It appear to working perfectly and able

to process a fixed-point square root value precisely.

The focus of this project is to implement square-root algorithm that appears
to be hard to implement on hardware. This was successfully done by creating a
digital system to operate as according to the square root algorithm used that is the
Non-Restoring Square Root Algorithm. Using the hardware description languages,
the implementation of the system to hardware can be verified through simulation and

it was proved to be successful.

5.2 Recommendation

The work in this project suggests that future improvement can be carried out to
improve the design to achieved better output result and execution performance. Below is

some proposed work:
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The first recommendation is to create a floating point square-root output value.
This can be done by adjusting the Data Path Unit digital design. However by adjusting
the Data Path Unit, the Control Unit also has to be adjusted. In other words, we have to
revise back the whole system design and control sequence of the Data Path Unit
operation [10].

The second recommendation is to increase the performance of the execution time
of the digital design operation of calculating the square-root value. In other word, we
want the digital system to operate and compute output faster. This recommendation can
be achieved by adjusting the digital design. We can try to reduce the clock cycle used to
get the output, without changing the algorithm used. This approach however will

increase the component used, hence increase the cost of the digital design [9].

Next recommendation is to creates a Graphical User Interface(GUI) in order for
user to input the data to the digital system without the need to studies the VHDL
languages. In other word, any user with various background can use and operates the
digital system created to calculate the square-root of input data. This can be done by
using other software that can interface with VHDL development software, for example is
MATLAB. This mostly depends on the VHDL software and the developments board
with which software of GUI can it interface with [11].

Finally, as we can see that this project only operates on simulation, we can
implement the digital design to hardware. For the VHDL used, that is ISE 10.1, this
software is specially developed to be compatible with Xilinx FPGA board. So, we can
somehow implement it to Xilinx FPGA and operates the digital system in hardware.
Further analysis can be done on the digital design on how effective it operates on real

hardware compared to simulation result [1][9].
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APPENDIX A

BEHAVIORAL CODE FOR EACH COMPONENT

A.l. ‘D’ Register

library IEEE;

use IEEE.STD_LOGIC_1164.ALL;

use IEEE.STD_LOGIC_ARITH.ALL;

use IEEE.STD_LOGIC_UNSIGNED.ALL,

entity D is

generic(width:integer:= 16);

Port ( Output_D1:out STD_LOGIC_VECTOR ( 1 downto 0);
Data_ D:in STD_LOGIC_VECTOR ((width-1) downto 0);
Enable_ D :in STD_LOGIC;

Load:in STD_LOGIC;
Clock_D:in STD_LOGIC;
Reset_D :in STD_LOGIC);

end D;

architecture Behavioral of D is
Signal R: std_logic_vector((width-1) downto 0);

Begin process(Clock_D)
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begin

if (Clock_D ="1"and Clock_D'EVENT) then

if (Reset_D ="'1") then

R <= (others =>'0");

elsif (Load = '1') then

R <= Data_D;

elsif (Enable_D ="'1") then

R(0) <= 0';

R(1) <=0’

for index in 0 to width-3 loop

R(index+2) <= R(index);

end loop; end if; end if; end process;

Output_D1 <= R((width-1) downto (width-2));

end Behavioral;

A.2. ‘Q’ Register

library IEEE;

use IEEE.STD_LOGIC_1164.ALL;

use IEEE.STD_LOGIC_ARITH.ALL;

use IEEE.STD_LOGIC_UNSIGNED.ALL,

entity Q is

generic(width:integer:= 16);

Port ( Output_Q : out STD_LOGIC_VECTOR (((width/2)-1) downto 0);
Leftl_ Q:in STD_LOGIC;

Enable_Q:in STD_LOGIC;
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Clock_Q:in STD_LOGIC;

Reset Q : in STD_LOGIC);

end Q;

architecture Behavioral of Q is

Signal R2: std_logic_vector(((width/2)-1) downto 0);

begin

process(Clock_Q)

begin

if (Clock_Q ='1"and Clock_Q'EVENT) then

if (Reset_Q ="'1") then

R2 <= (others =>"'0');

elsif (Enable_Q ="'1") then

R2(0) <= Leftl_Q;

for index in 0 to (width/2)-2 loop

R2(index+1) <= R2(index);

end loop; end if; end if; end process;

Output_Q <=R2;

end Behavioral,

A.3. ‘R’ Register

library IEEE;

use IEEE.STD_LOGIC_1164.ALL;

use IEEE.STD_LOGIC_ARITH.ALL,;

use IEEE.STD_LOGIC_UNSIGNED.ALL,
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entity R is
generic(width:integer:= 16);
Port (Data_R :in STD_LOGIC_VECTOR ((((width/2)+2)-1) downto 0);

Enable_R :in STD_LOGIC;
Reset R :in STD_LOGIC;
Clock_R:in STD_LOGIC;
Output_R3:out STD_LOGIC_VECTOR (((width/2)-1) downto 0);
Output_R1:out STD_LOGIC);

end R;

architecture Behavioral of R is

signal Data_R2_1,mask :STD_LOGIC;

signal Data_R2_2 :STD_LOGIC_VECTOR (((width/2)-1) downto 0);

begin

process(Clock_R)

begin

if(Clock_R'event and Clock_R = "1")then

if(Reset_R="1")then

Data_R2_1<= 0’

Data_R2_2 <= (others =>'0");

elsif Enable_R ='1"then

Data_R2_1 <= Data_R(((width/2)+2)-1);

mask <= Data_R(width/2);

Data_R2_2 <= Data_R(((width/2)-1) downto 0);

end if; end if; end process;

Output_R1 <= Data_R2_1;

Output_R3 <= Data_R2_2;

end Behavioral;
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A.4. ‘N’ Gate Logic

library IEEE;

use IEEE.STD_LOGIC_1164.ALL,;

use IEEE.STD_LOGIC_ARITH.ALL;

use IEEE.STD_LOGIC_UNSIGNED.ALL,

entity N is

Port (In_N : in STD_LOGIC;

Out_N : out STD_LOGIC);

end N;

architecture Behavioral of N is

begin

Out_N <=not In_N;

end Behavioral,

A.5.  Adder/Subtractor

library IEEE;

use IEEE.STD_LOGIC_1164.ALL;

use IEEE.STD_LOGIC_ARITH.ALL,

use IEEE.STD_LOGIC_UNSIGNED.ALL,

entity AddSub is

generic(width:integer:= 16);
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Port (A_in2 : in STD_LOGIC_VECTOR (1 downto 0);
A_inl:in STD_LOGIC_VECTOR (((width/2)-1) downto 0);
B_in3:in STD_LOGIC;

B_in2:in STD_LOGIC;
B_inl:in STD_LOGIC_VECTOR (((width/2)-1) downto 0);
S out:out STD_LOGIC_VECTOR ((((width/2)+2)-1) downto 0);
control_op : in STD_LOGIC;
Clock_as : in STD_LOGIC;
enable_as : in STD_LOGIC;
reset_addsub : in STD_LOGIC);

end AddSub;

architecture Behavioral of AddSub is

signal R3 : std_logic_vector(((width/2)+1) downto 0);
begin
process(Clock_as,A_in1,A_in2,B_in1,B_in2,B_in3,control_op)
begin

if(Clock_as'event and Clock_as = '1")then

if (reset_addsub ="1") then

R3 <= (others =>'0");

elsif (enable_as ='1") then

if (control_op ='1") then

R3<=(A_in1 & A_in2) + (B_in1 & B_in2 & B_in3);
elsif (control_op ='0") then

R3<=(A_in1 & A_in2) - (B_in1 & B_in2 & B_in3);
end if; end if; end if; end process;

S _out<=R3;

end Behavioral;
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A.6. Counter

library IEEE;

use IEEE.STD_LOGIC_1164.ALL,;

use IEEE.STD_LOGIC_ARITH.ALL;

use IEEE.STD_LOGIC_UNSIGNED.ALL,

entity count_reg is

Port ( clock_count : in STD_LOGIC;

reset_count : in STD_LOGIC;

enable_count:in STD_LOGIC;

count_i : out STD_LOGIC);

end count_reg;

architecture Behavioral of count_reg is

signal count : std_logic_vector(3 downto 0);

constant termcount : std_logic_vector(3 downto 0):="0000";

begin

process(clock_count)

begin

if(clock_count ='1"and clock_count'event) then

if reset_count ='1' then

count <= "1000";

elsif enable_count ='1' then

count <= count-'1";

end if; end if; end process;

count_i <="1"when count = termcount else '0';end Behavioral;
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A.7. Output Register

library IEEE;

use IEEE.STD_LOGIC_1164.ALL,;

use IEEE.STD_LOGIC_ARITH.ALL;

use IEEE.STD_LOGIC_UNSIGNED.ALL,

entity Output_reg is

generic(width:integer:= 16);

Port (in_reg : in STD_LOGIC_VECTOR (((width/2)-1) downto 0);
out_reg : out STD_LOGIC_VECTOR (((width/2)-1) downto 0);
clk_reg:in STD_LOGIC;
enable_reg : in STD_LOGIC;
rst_reg :in STD_LOGIC);

end Output_reg;

architecture Behavioral of Output_reg is

begin

process (clk_reg)

begin

if (clk_reg ='1"and clk_reg'EVENT) then

if (rst_reg ='1") then

out_reg <= (others =>'0");

elsif (enable_reg ='1") then

out_reg <=in_reg;

end if; end if; end process; end Behavioral;
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B.1 Lab1l

PROCEDURE
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Create a new praject
1. Open the Xilinx Foundation ISE design tools from Start>Programs>Xilinx ISE
9.2>Project Navigator
2. Create a New Project from the Project Navigator’s menu. FILE ->New Project

3. Fillin the New Project Dialogue box as follows: Note: To set the Project Location
field o C:hSpeedway, VHDLY XORZVHDL; navigate to the G\ Speedway, VDL

directory in the Project Location and the enter XORZVHDL in the Project Name field.

B New Project Wizard - Create Mew Project

Enbee & Marme ard Location for the Project
Fropct Mame; Froject Location
HORZHDL (LSt HOLHORZVHDL | =]

Select the Tepe of TopLewel Source for the Pioject
Top-Lervel Soapee Type:
HOL w

o




4. Enter the project options:

B New Project Wizard - Device Properties

Select the Device and Design Flow for the Project

Propesty Marme Vale

Product Calegony Al w
F arily Spartan3t v
Device =C35500E “
Package FG320 w
i I
TopLevel Souce Tupe [HDL

Synibesiz Tool #3T [(WHOLAYenlog) v
Simulator ISE Simulator (HOLAferiiog) v
Prefened Language WHOL v

Enable Enhanced Design Summany
Enable Message Fitering E]
Display Incremenital Messages E]

[ < Back || Mext > ][ Cancel

5. Create a new source by selectng the New Source button.

—LCreate a Mew Source

Sourze File Type

1 ——
Hemoye |




6. Fill in the New source window as follows

£ New Source Wizard - Select Source Type

4] IP[Coregen & Architecture Wizard)

Verilog Module Eil= name:
Verilog Test Fidte
m YHOL Module HORZVHOL vid
[ VHDL Libray L
[#] WHOL Package :
[ VHDL Test Bench £\ peadwa\WHDLWOR2VHDL |
™| Embeddead Processor
Add to progect
¢Back || New> | [ Caneel

Select Next button

B. Filin the Define VHDL Source window as follows m set up the 1/0s.

E New Source Wizard - Define Module

Entity Name [X0RZVHDL |
Architectae Name |Buhm-i:\|a| |
Piost Mame Direction Bus | MSE L5B ~
IN_A& n ~O
IN_E in v
ouT C ~
]
~
~ O
~O
]
~
+ [ >
| < Back “ Hext > ] [ Carcel

9, Select the Next button.
10. Cliek Finish -> Yes -> Next -> Next -> Finish.

11. A summary window opens.
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12. Click next or OK untl the form completes. Do not add any other files. This will bring
up ISE with the HDL Editor open ready to edit the ereated VHDL file,

13. Add the VHDL code for the 2-input XOR funeton within the Architecture,
(Hint: OUT_C <= IN_A XOR IN_B;

14. Save the file by selecting FILE -> SAVE or by dicking on the floppy disk icon on the
ool bar

Check the Syntax

15, Make sure the file XORZVHIL is selected in the Sources in Project window.
16. Check that Sources for Synthesis/ Implementation is selected.

17. In the Processes for Current Source window expand the Synthesize-X8T process and
double click Check Syntax.

I_T—_ly User Constraints
E-8)  Synthesize - XST
View Syrthesis Report

Wiew ATL Schematic

iew Technology Schematic
Ch 1

Generate Post-Synthesis Simulaton tModel

L

IOWNCES thI Synthesiz/mplementation
T~ B 0R2vHDL
B £ vee1 00e-dig1 44
b R ORZVHDL - Behavioral (KOR2VHDL vhd)

18. If the syntax check fails fix any errors before proceeding. Syntax errors can be located
by checking the Project Navigator console window on the bottom of the screen. They

3 ERROR:

are flapped with an marker.. Clicking on the hypertext of the file

name will take you to the error.

Using the ISE Simulator

ISE Simulator is a design simulaton tool included in with the Xilinx wols that allows a user to
generate and simulate HDL test benches using a graphical represenmaton of the input and
expected output behavicr of the code.

19, In the Sources for window switch to Behavioral Simulation



54

20, Double click Create New Source in the Process window. From the New Source
window select Test Bench Waveform and name the file XORZVHDL th.

21. In the Associate with Source window select xor2vhdl and click Next

22, HDL Bencher will open with the inidalize dming dialog window. Make sure that the
“Combinatorial Design (Or internal clock) box is selected. Accept the default
values and click Finish to close the dialog box.

23. The HDL Bencher waveform editor will open. The waveform editor allows the user
shape input waveforms at each time step. By clicking on a wave at a particular time the
value of that wave can be entered. Edit the waveform o look as shown below,

I X02VHDL_tb.thw
Fie Edit View TestBanch Smulation ‘'Window

i H e ey P4 2LHH BN E N e ™

End Time:
1000 ns &0 180 280 30 450 850 650 750 esn o4

T T e I T I

LTSI [ o o O
anm_e [ |
Mout_c 1]

|

24, Save the wave form and close the editor.

25, The waveform should be visible as the top file in the Behavioral simulation view of the
desipn.

26. Select the testhench wave form in the Sources For Behavioral Simulation window.
It might be necessary to set the Behavioral Simulation in the Sources for pull down
box.

27. Taunch a simulation by clicking the “+” tab next to Xilink ISE Simulator in the proeess
window and double dicking “Simulate Behavioral Model”..

28. The ISE Simulator should start up and run the simuladon. In the ISE console window
the message should appear “** Failure: Simulation successful (not a failure). No
problems detected.” Indicating that the simulation was successful.

29. Examine the waveform, does the output march what is expected from an XOR gate?
30. Exit Project Navigator and click Yes t close the simulation

3l End Lab 1



B.2 Lab 2

VHDL MUX lab

Overview: This lab will fllustrate using a verity of VHDL statermnents to build a basic
circuit..

Objective: To code and successfully simulate a 4 to 1 bus multplexer using any valid
eonstruct discussed in Section 2 of the instruction. The multiplexer has four data bus inputs
of eight bits each and a 2 bit select line that controls the 8-bit output of the multiplexer. A test
bench that has already been created will be used to confirm the operation of the MUX.

PROCEDURE

Open an existing praject

[, Open the Xilinx Foundadon ISE design wols from Start>Programs>Xilinx ISE
9..2>Project Navigator

2. Open the project Muxdx8. From the Project Navigator menu selece File>Open
Project and navigate o the directory Cr\Speedway\VHDL \ mux4x8. Double click
o the file mux4x8.ise w open the project.

Create a new design file
3. Rightclick in the Sources In Project window. Select New Source from the drop
down menu.
4. Select VHDL Module from the New Sources menu.
Enter mux4x8 in the File Name field. Click Next.

6. Fill cut the Define VHDL Source window to match the figure below. Notce that all
of the signals have a bus width. To enter abus click the Bus select box then enter the
width in the MSB field of that signal

7. Werify all sipnals entered have direction IN except for the signal MUX__OUT whose
direction is OUT as shown in following figure, Ttis very important that the names be
EXACTLY the same.

Ln



EE New Source Wizard - Define Module
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10| x|

Entity Mame | musdé

Architecture Mame |Behavima|

Part Mame Direction Bus |MSE LSB -
n_a in - | 7 0
in_b in - | 7 0
in_c lin | 7 0
fin_d lin ~ | 7 0
sel i - |~ 1 0
IraLi_out out - |i 7 0

Jin %I_
i -

|in

lin

Ad

Muore Info |

<Back || New> Carcel |

8. Onee the form has been filled out click Next, then Finish completing the setup and
starting the VHDL editor.

Write VHDL to construct the MUX

9. Using any of the methods oudined in the slides fill in the architecture to make a 4 o 1
mmux and save the file,

10, Use the syntax checker in the Processes for Current Source window tm verify that the

syntax 1s correct.

11. Correct all syntax errors before contnuing.

Simulate the design

12, Check to insure that the Sources view is set to Behavioral Simulation. The sources
should show the existing testbench MUX4XE_th at the top of the hierarchy with your

design file below it.

13, Select the test bench file MUN4NE_th in the Sources view., The Process window
should now have the Xilinx ISE Simulator visible, Expand the Xilinx ISE Simulator
icon by dicking on the "+ sim. The choice Simulate Behavioral Model should be
available, Select Simulate Behavioral Model to launch the ISE simulator,

14, The ISE simulator should run o completdon. A message similar to:

** Failure:Simulation successful (not a failure). No problems detected.

UserVHDL) Code Called Simulaton Stop

should appear in the ISE console window. If the simulation failed for other reasons
then eorrect the VHIDL source code m ger a successful simulatgon,

15. Onee the simulaton is successful close the ISE simulator,
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Lab 3

VHDL Flip-Flop lab

Overview: This lab will illustrate the use of signal definitions for VHDL coding.

Objective: To code and successfully simulate a flip-flop whose input is fed from
combinatoral logic as shown by the schematic below. A test bench that has already been
ereated will be used to confirm the operation of the circuit.

[SRsT
B
[B—] 5

ANDZ2

i‘//}i D Q@ — FLOP_OUT>
D E— OR2 CE
c

o )

ANDZ

=

[ CLK

PROCEDURE

Open the existing project

1. Open the Xilinx Foundatdon ISE design mols from Start>Programs>Xilinx
Foundation Series [SE 9.2>Project Navigator

2. Open the project Flop_Lab. From the Project Navigator menu select File>Open
Project and navigate o the directory Cr\Speedway\VHDL\Flop_lab. Double click
on the file Flop_lab.ise to open the project. The project should open with the test
berich alteady added but no actual desipn entered. Itis the purpose of the lab to enter
the design.



Create a new design file

3. Right click on the Sources In Project window. Select New Source from the drop
down menu.

4. Select VHDL Module from the New Sources menu.

5. Enter Flop_Lab in the File Name field and click Next.

6. Fill out the Define VHDL Source m match the table below. Note that sipnals will
have to be entered into the actual VHDL mde because the define source routine only
creates ports not signals.

Port Name Direction Description
A In Logic input
B In Logic input
C In Logic input
D] In Logic input
EN In A Clock enable. When EN="1" the circuit can
dock. When EN="0" clocking is disabled.
(LK In The system clock, active edge is rising,
SR&T In A synchronous reset, When SRST="1"
FLOP_OUT ="7 when the circuit is docked.
This control overrides the clock enable.
FLOP_OUT (Out The circuit output.
7. Onee the form has been filled out elick Next then Finish w complete the setup and

start the VHDL editor.

Wrrite VHDL to construct the circuit

B.

o.

To code the cireuit you will need at least one eoncurrent statement for the
eombinatorial logic and one process for the register,

Use the syntax checker in the Processes for Current Source window to verify that the
Syntax 1§ correct

10. Correct all syntax errors before continuing,

Simulate the design

11
11

. Select the file FLOP_LAB_TB.VHD in the Source in Project window,

. Expand the icon for Nilink ISE Simulator in the Processes for Current Source

window,

. Select Simulate Behavioral Model and double click on it m start the simulation

. The ISE simulator should run o compledon. A message similar to:
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* Failure: Simulation successful (not a failure). No problems detected.

#  Time: 380 ns Iteration: 0 Instance: /testhench”™

should appear in the ISIM console window. 1f the simulaton failed for other reasons
then correct the VHDL source code m get a successful simulation.

15. You may zoom to view all the simulation tme in the WAVE window of ISIM by
selecting the View=>Zoom In and Out menu and then Zoom Full.

16, Onee the simulation is successful dose the ISE simulator and Project Navigator,
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B.4

Lab 4

VHDI Counter lab

Overview: This lab will flustrate the use of the language assistant, an additional tool
available with the Xilinx tools that provides language templates for proper usage and syntax of
HDL constructs,

Objective: Create and verify the correet operation of a loadable six-bit up counter with a
eloek enable and a terminal eount. The counter has the following ports. A tese bench that has

already been created will be used to verify the operation of the circuit.

Port Name Direction Description
CLK In System clock
CE In Clock enzhble input. Aetve LOW! When CE = 1 the counter remaing

in it’s present state, When CE = 0 the counter increments or loads data,
CE has no control of SRST.

1. In input. When L=1 and CE=0 the counter loads the value
nted arits DATA input. When L=0 and EN=0 the counter
inerements.
SRST In Synchronous reset input. Active High, Counter reset to “000000",
Owerrides the state of CE and L.
DATA In 6 bir Data input tor load the counter with 2 value.
COUNT_OUT Ot The counter’s ourput value. 6 bits. The count our should normally
count up from 0o “1110117 and then retum to 0.
T Or Terminal Count output. TC should be ‘1" when COUNT_OUT =

“U11011" otherwise it should remain at 0° TCis 2 combinatorial sigral
and should not be repistered

PROCEDURE

Open an existing project

Open the Xilinx Foundation ISE design tools from Start>Programs >Xilinx
Foundaton Series ISE 9.25>Project Navigator

2. Open the project Counter_Lab. From the Project Navigator menu select File>Open
Project and navigate to the directory C:\Speedway\VHDL\ counter_lab. Double
click one the file counter_lab.ise t open the project.
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Open the design File

3. Thedesign comes with the TestBench and a skeleton of the design file started. Itis the
goal of the lab to complete the design file. to meet the functon deseribed in the
Objective section

4. Open the design file called muntervhd by double dickingon it in the Sources Project
Window.

Write VHDL using the Language assistant

5. Apre-made counter will be used as the start of the design

2
6. Click on the Language Assistant button along the top menu ba.t"

Highlight the template VHDL'\Synthesis Construets| Coding
Examples', Counters’, Binaryh Up Counters

8. Locate the counter that most closely matches the requirernent and select it in the
language assistant.

9. Righeclick d1e| ‘imn in the language assistant to add the process skeleton to the
HDL eode.

10, Complete the rest of the HDL to make the needed counter crcuit.

A few things to notice

4. No Template eounter has a TC so you will have o add one. Don't forget that
TC also clears the counter.

b, You will need o make a local copy of COUNT_OUT.

11, Use the syntax checker in the Processes for Current Source window to verify that the
SVNtX 1§ correct.

12, Correct all syntax errors before continuing. While debugging the aode you might geta
aonsole message to “Turn off Incremental Compiladgon”. This can be down by
selecting the testhench, “eounter ATB,” in the sources window and then right clicking
on Simulate Behavioral Model in the Processes window. Select Properties and un-
check the Incremental Compiladon button,

13, Simulate the design, Select the file COUNTER_ATB.VHI in the Source in Project
window

14, It might be necessary to tpe “run all “ o force the simulator  run o compledon,

15, Select Simulate Behavioral VHDL model. The ISE simulator should run
completion. A message similar to:

“ Failure: Simulation sueeessful (not a failure). No problems detected.
# Time: 1060 ns Iteration: 0 Instance: /testhench”

should appear in the ISE console window.

16. If the simulation failed for other reasons then correct the VHDL source code to geta
successful simulation,

17. Onee the simulation is successful close the ISE simulator and Project Navigator



B.5 Lab5s

LAB 5

VHDL State Machine Lab

Overview: To design and simulate a stare machine using VHDL.

Objective: To encode a 3 state machine and verify its correct operation. The finite state

machine should be coded to have its ports function as described below and to transition
through the states as described in the bubble state diagram below. A test bench has already
been created and will be used to verify the correct operation of the dreuit.

BLUE, YELLOW,
START

Port Name Direction Description

LK In System clock input

EN In Clock Enable input. When EN=0 the
machine remains at it’s present state. When
EN=1 the state machine advances to the next
state.

SRST In Synchronous Reset input. Active high

ColorOne, ColorTwo In The control inputs to the state machine
RED, GREEN, Out The state machine outputs

PROCEDURE

Open an existing project

Open the Xilinx Foundaton ISE design tools from Start>Programs >Xilinx
Foundation Seres I1SE 9.2i>Project Navigator

2. Open the project C:\Speedway \ VHDL\STATE\STATE.ise
Open the design file for editing

3. Thedesign file is statewhd

4. Fill put the Define VHDL Source window to match the given ports,

Write VHDL to construct the circuit

5. Reference the following state diagram. Complete the rest of the HIDL to make the

needed counter circuit..
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6.

Use the syntax checker in the Processes for Current Source window -L-erifg.- that the
SYMaX IS COrrect.

Correct all syntax errors before contnuing,

Simulate the design and access additional waveforms

8.
9.

L.

11.

12,

13

14,

Select the file STATETB.VHD in the Source in Project window.
Seleet Simulate Behavioral Model.

The ISEsimulator should run, it might be necessary to type “run all” in the console
window to complete the simulaton.:

F ailure: Simulation suceessful (not a failuré). No problems detected.
#  Time: 1760 ns Iteration: O Instance: /testbench™

should appear in the ISE console window.

If the simulation failed for other reasons correct the VHDL souree code to get a
successful simulation.

A good technique to debugging the circuitis to add the PRESENT state signal to the
simulation view. Lower level signals can be added to the simulation view by expanding
the hierarchy of the test bench t open the UUT. Once the UUT signals are visible the
sipnal PresentState can be dragped m the waveform window.

It might be necessary o restart the simulator and rerun to see all of PresentState. This
can be done by typing “restart” and “run all” in the simulator console window.

Oinee the simulation is successful close the simulator,
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B6 Lab6

LAB 6

VHDL Port Map Lab

Overview!: This lab will illustrare hierarchical VHDL design methodology covering
instantiation and packages.

Objective: To create a top level VHDL file that completes a hierarchical design. The
dtsign uses a package that containg all the component declaratons; this package must be
completed as part of the lab. The design instantiates the state machine used in lab 3 along
with a counter and the XOR design created in during labl. The project has been started
for the student and working versions of the counter and state machine are available,

PROCEDURE

Whatis in the Project

This project is partially complete; it contains a working version of the eounter needed for
this design COUNT.vhd file, a working XOR gate design, and the state machine from
Lab 3. It also contains a package called My_pack. My_Pack is not complete; it is missing
the component entry for the State Machine and the XORZVHID. To help visualize the
design a schemaric is supplied below.

[CoiorTwa
Inat_stabe |k
CATAS D,
= counter _ State
ColwTwo  GREEN
DATA[ED]  COUNT_CUTE —=%
- — [ ColwDne BLUE ELLE
= | s ) . = e me0———{AED>
RE J H_# . —————SRST  YELLOW ———{NELLOW »
/
cix LK Tt

SRST

CLI

Open an existing Project
1. From the File menu in the Project Navigator tool bar select Open Project..
2. Open the project named C\Speedway '\ VHDL Ports' Portsdse

Complete the design
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Open the file My_Pack.vhd (Note: it might be necessary to search through the
hierarchy of the design to find My_Pack, also one can find My_Pack by selecting the
libraries tab in the sourees window on opening the library work) and add eomponent
staterments for the two missing components State_lb and XOR2ZVHD to be
instantiated in the top-level design. Use the View HDL Instantiation Template
feature of ISE to generate the component statement,

Notice that the terminal count for the COUNT eireuit is being set up in My_Pack by
defining the constant t_count.
Save and elose My_Pack.

Create a new VHDL module using the Project Navigators Project>New Soutrce
option,

The file should be called "TOP_VHD" and should have the following ports.
Inputs CLK, SRST, XA XB,CE,Data(5:0), ColotOne, ColotTwo

Outputs  GREEN,BLUE,RED,YELLOW, START

Write the VHDL to correctly describe the design shown below. Make sure m include
a call to use My_Pack library. Notice that a few signals will have to be added to the
top level design to transport data from one instantiated entity to the next. Also notice
that the eounter port C_OUT is not connected. This is ok, however to suppress any
warning statements for synthesis tools 4 connection can be made to the VHDL
keyword openin the counters port map statement.

Hint: Design Entry Utilities=>View VHDL Instantiation Template. This eould
be helpful.

. Seleet TOP_VHD in the Sourees and when the file passes a syatax cheek save the

file.

. The ISE Project Navigator should now show the full hierarchy of the design in the

Source in Project window as shown below.

S ources in Project: I
~-[@ PORTS
=-£3 #e251005pa208
[P my_pack (my_pack vhd)

= @ top_vind-bekaviaral (TOP_VHD. vid)
@ testbench-testbench_arch (TOP_VHD_TBVWHD)
counter-behaviaral [counter. vhd]
state-behawioral (St ate. vhd)
wor2vhdl-behavioral (xor2vhdl vhd]

N By Module View l I8 Shapshot Views ‘ |E Libtary Vigwn I




Verify the design using the ISE Simulator

12, BEFORE SIMULATING Check that Incremental Compilation is turned off. Select
the test bench then right click Simulate Behavioral Model and select Properties.

13, Make sure the Display Level i set to Advanced.

14, Select the testhench and double click on the Simulate Behavioral VHDL Model in the
Processes for Current Source window,

13, It may be necessary to force the simulator to run for a longer time to get the
completion message.  Enter the command >run ALL o foree the simulator to run
to compledon,

16.

o

The simulation should complete successfully. Ifit failed, return to the source code
and make any corrections necessary.



